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SYNOPSIS


The Mobile Information Provider [MIP] is aimed at providing information handy to the user of its Mobile Service. The user could obtain the information regarding the location, which the user wants to get, by a click on his handset.


The total operation is obtained by a combination of the front end a mobile handset with designed user interface in WML (Wireless Mark-Up Language) and at the backend a Web Application Server (J2EE) with a database in SQLServer.


The information that are provided by the Mobile Information Provider are the local information of the area which includes

· Hotels

· Tourist Spots

· Travel Agency

· Train Details

· Hospitals

This is a Multi-Tiered application with layers intermediating between the user and the web application server these layers are abstractions of the operation logic. These abstractions are done using components. Java Server Pages (JSP) bridges the whole operation between the user and services.

The database is a RDBMS with high security and authentication. The database connection and its operation have been done using JDBC (Java Database Connectivity).




3.SYSTEM REQUIREMENTS 

3.1 HARDWARE REQUIREMENTS :

· Processor

     Intel  Pentium  Family

· Clock Speed                   667 MHz

· RAM                     
    128 MB

· Hard Disk             
    10 GB or  higher

· Monitor                          Display  panel  (640  x  480)

· Keyboard                       Standard  104  enhanced  keyboard

· Cache Memory    
    11,011,968 Bytes

· Virtual Memory  
    32 MB

· Display Card       
    Super Video Graphics Adapter (SVGA)
3.2 SOFTWARE REQUIREMENTS:

· Server


    J2EE Server 1.2.1

· Browser

    Nokia Simulator 4.0

· Server side scripting     Java Server Pages

· Database

    Oracle

· Language

    WML(wireless markup language) 



4.TOOLS USED

4.1 Detailed Explanation of the Simulator Environment

· Nokia Mobile Internet Toolkit 4.0

· Nokia Browser 4.0

· Nokia 5100 SDK

· Nokia WAP Gateway
Nokia Mobile Internet Toolkit:

Nokia Mobile Internet Toolkit (NMIT) consists of a set of editors for creating various types of mobile Internet content. NMIT enables the display of this content on multiple supported phone SDKs, such as the Nokia 5100 Content Authoring SDK as well as the Nokia Mobile Browser Simulator (NMB) “concept” phone SDK.

Phone SDKs are installed separately. NMIT detects installed, supported phone SDKs at startup and lists these in its SDK Control Panel. You can display content you author on any supported phone SDK by simply clicking a Show button within an editor.

Most NMIT editors are used for creating XML-based content types defined by Document Type Defintions (DTDs). These editors employ content validation to check content against a DTD, and they provide features for easily selecting elements and attributions for insertion based on current cursor position. In addition, NMIT provides a DTD Manager through which you can import new  DTDs for use by NMIT editors.

NMIT also makes available a loosely integrated tool for creating encrypted content that is intended for access by digital rights objects: the Digital Rights Management (DRM) tool.

Features in NMIT 4.0 over NMIT 3.0

Nokia Mobile Internet Toolkit (NMIT) 4.0, which has been newly redesigned to focus primarily on content authoring features and to support multiple active phone SDKs. NMIT 4.0 differs considerably from the previous NMIT 3.1 version in these  following 

• WAP Server Simulator, newly renamed Nokia WAP Gateway Simulator (NWGS)

• Nokia Mobile Browser (NMB) 3.01 device simulator, newly renamed Nokia Mobile Browser (NMB) Simulator4.0 In addition, the NMIT 3.1 set of tab views for viewing Current, Session, Bookmarks, WTLS, and WIM information are not included in NMIT 4.0. These views, which are used for diagnostic monitoring of the interaction of phone SDKs with the network, have been integrated within each phone SDK and made accessible through a window attached to each running SDK instance.

This redesign of NMIT provides several benefits such as the ability to:

·  Launch multiple phone SDKs and multiple instances of most individual    phone SDKs.

·  Send content simultaneously to multiple instances of running phone SDKs .

·  Launch diagnostic views from running individual phone SDKs with view panels targeted individually to phone SDK capability; for example, WIM and WTLS views are absent from  the diagnostic views of phone SDKs that do not support these functions.

·  Associate file types with NMIT editors during NMIT installation so that double-clicking a file of that type opens the file in an NMIT editor.

NMIT TOOLS :

• SDK Control Panel: This tool for managing phone SDKs is an integral part                            

   of NMIT


• DTD Manager: This tool for supplementing the DTDs used by NMIT’s XML-based editors is an integral part of NMIT 

• DRM (Digital Rights Management): This tool for publishing content protected by digital rights technology is a separate application, not integrated with NMIT.

• WAP Gateway: This tool, a single-user WAP gateway, is a separate application, not integrated with NMIT

Nokia 5100 SDK:

The Nokia 5100 Software Developer’s Kit (Nokia 5100 SDK) is a development tool that lets you preview how wireless content will look and work when it is ultimately deployed to an actual Nokia 5100 mobile handset .  Nokia 5100 SDK can also be used to develop content for other Nokia handsets with characteristics and functionality that are similar to that of the Nokia 5100 handset.

The Nokia 5100 SDK has an XWML color browser and an HTTP communications stack that lets the SDK directly receive from web servers without going through a WAP gateway. 

With this SDK, you can view local files or receive mobile Internet content using an  HTTP connection. 

Such content includes:

·  Web content designed to be browsed on a mobile phone, such as browsable                 
WML and XWML content

·  Wireless messages such as MMS (multimedia message service) and SI/SL 
(Service Indictor/Service Load) Push messages

[image: image2.png]The SDK’s main window looks I

SDK Instance number

v

like this:

| sokMenus

[ content display
128x126 canvas size.

| teftsoft key activates function
onlef in this exampie, Menu)

{——Right soft ey activates function
onright (in tis exampie, Names)
| Up and Down keys for scroling

Startcal  Endcal




To simulate pressing the buttons on a Nokia 5100 mobile handset, click the

corresponding keys on the SDK with the mouse. The SDK replicates the user interface of the Nokia 5100 phone handset with respect to its key definitions, menus selections, message display, backlight and vibration modes.

The menu structure displayed in the SDK’s user interface is identical to that of the Nokia 5100 phone handset, although not all menus in the SDK work identically to their Nokia 5100 handset counterpart because the SDK is not a phone but a developer’s tool. For example, you cannot make a phone call on the SDK. When you place a phone call, the SDK simulates placing the call to the extent that you have to cancel the call function by clicking the End Call key, but the call is never placed.

The appearance of the SDK is faithful to the appearance of the handset, although the contrast and color rendering capabilities of each might differ slightly because of differences in monitor calibration and imaging technologies.

Nokia Mobile Browser 4.0 SDK (NMB):

NMB is a mobile phone SDK that includes a mobile Internet browser for browsing both mobile Internet content (through a WAP connection) and local file content. It fully supports the content authoring features of Nokia Mobile Internet Toolkit 4.0 (NMIT) and can be used to display both xWML and wml content, as well as Push messages. It also can be used standalone.

• NMB 4.0 can be launched as a standalone browser or used in conjunction 
with Nokia Mobile Internet Toolkit (NMIT), or both simultaneously.

• Multiple instances of NMB 4.0 can be launched simultaneously and used  
independently, and  can display NMIT 4.0 content on all running 
instances of NMB 4.0.

• NMB 4.0 provides diagnostic views through its Tools>Diagnostics menu. 
These views are displayed in a separate window adjoining the NMB 4.0 
window.

NMB is a development tool intended for mobile Internet content developers who wish to preview how their content will look before it is ultimately deployed on a mobile phone handset. Using NMB, content developers can display any mobile Internet content developed using Nokia Mobile Internet Toolkit 4.0 (NMIT), as well as local file content and content resident on Internet servers and accessed through a WAP connection. WAP connections may be made through either a  WAP gateway server or through Nokia’s WAP Gateway Simulator (NWGS).

NMB uses the Nokia Mobile Browser software, which has been developed by Nokia for deployment on actual phone handsets. However, NMB is not designed to reflect the functionality of any particular handset but rather an extensive range of current and evolving technologies of interest to mobile Internet developers.


NMB can be used in a standalone fashion to load local or mobile Internet content. It can handle all  content types capable of being created within NMIT except Multimedia (MMS) messages.
Additional features of NMB include the following:

•  Establish secure connections to an external WAP gateway using the 
WTLS 
protocol, levels 1, 2, or 3.

• Provides  WIM security features (Certificates, PINs, and Keys) and display 
information about these in NMB’s WIM view.

• Receive unsolicited Push messages from an external WAP gateway. NMB 
listens for these on a specified port.

WAP Protocol Support

The Nokia Mobile Browser 4.0 SDK supports the WAP June 2000 (or WAP Version 1.2.1) specifications. Supported content includes WML, WML Script, and

XWML, as well as WBMP and GIF image formats.

WAP-Specific Functions Supported

• WTAI public library

• GPS and GSM location information

• WIM and WTLS security functions

• Push message reception

Other Support

• Post

• Cookies

Character Set Support

The Nokia Mobile Browser 4.0 SDK supports the following character sets:


• US ASCII (ISO-8859-1)








• UTF-8

• UCS-2 (ISO-10646-UCS-2)

WAP Gateway

This is a single-user WAP Gateway based on the multi-user Nokia Active Server. When installed on our computer, NWGS enables us to access the mobile Internet through the phone SDKs that we can use in conjunction with NMIT.


NWGS provides a subset of the features provided by Nokia Active Server such as the following:

• WAP 2.0 compliance with support for wml , wmlscript , xWML , css and 
Push message content types.

• Encoders. NWGS encodes WML and WMLScript content on the way from 
the Origin Server to the client phone SDK.

• UDP/IP bearer adapter. This adapter enables communication between 
NWGS and other client user agents running in a local area network, such as 
Nokia Mobile Internet Toolkit (NMIT) and phone emulators. NWGS does 
not support other bearer adapters supported by Nokia Active Server as these 
are designed to enable radio communication between devices and the mobile 
Internet.

• User administration through a GUI, providing the ability to stop and start 
traffic, configure proxy and cache settings, and view and configure log file 
settings.

J2EE(Java 2 Enetrprise Edition):


Java 2 Plat-form, Enterprise Edition (J2EE) provides a component-based approach to the design, development, assembly, and deployment of enterprise applications. The J2EE platform offers a multi-tiered distributed application model, reusable components, a unified security model, flexible transaction control, and Web services support through integrated data interchange on Extensible Markup Language (XML)-based open standards and protocols.

This allows us to deliver innovative business solutions to market faster than ever. These platform-independent J2EE component-based solutions are not tied to the products and application programming interfaces (APIs) of any one vendor.

The J2EE platform uses a multi-tiered distributed application model for enterprise applications. Application logic is divided into components according to function, and the various application components that make up a J2EE application are installed on different machines depending on the tier in the multi-tiered J2EE environment to which the application component belongs. The following are a few components of J2EE architecture
• Client-tier components run on the client machine.

• Web-tier components run on the J2EE server.

• Business-tier components run on the J2EE server.

• Enterprise information system (EIS)-tier software runs on the EIS server.

Although a J2EE application may consist of the three or four tiers shown in the below Figure , J2EE multi-tiered applications are generally considered to be three-tiered applications because they are distributed over three different locations: client machines, the J2EE server machine, and the database or legacy machines at the back end. Three-tiered applications that run in this way extend the standard two-tiered client and server model by placing a multithreaded application server between the client application and back-end storage.
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Components of J2EE

J2EE applications are made up of components. A J2EE component is a self- contained functional software unit that is assembled into a J2EE application with its related classes and files and that communicates with other components. The J2EE specification defines the following J2EE components:

• Application clients and applets are components that run on the client.

• Java Servlet and JavaServer Pages (JSP) technology components are

 Web components that run on the server.

• Enterprise JavaBeans (EJB) components (enterprise beans) are busi-ness

components that run on the server.

J2EE components are written in the Java programming language and are compiled in the same way as any program in the language. The difference between  J2EE components and “standard” Java classes is that J2EE components are assembled into a J2EE application, verified to be well formed and in compliance with the J2EE specification, and deployed to production, where they are run and managed by the J2EE server.

The deployment process installs J2EE application components in the J2EE con-tainers as illustrated in the following figure .
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J2EE server

The runtime portion of a J2EE product. A J2EE server provides EJB and Web containers. Enterprise JavaBeans (EJB) container manages the execution of enterprise beans for J2EE applications. Enterprise beans and their container run on the J2EE server.

Web container

Manages the execution of JSP page and servlet components for J2EE appli-cations. Web components and their container run on the J2EE server.

Application client container

Manages the execution of application client components. Application clients

and their container run on the client.

Applet container

Manages the execution of applets. Consists of a Web browser and Java Plug-in running on the client together.

JAVA SERVER PAGES

JAVA SERVER Pages (JSP) technology allows us  to easily create Web content  that has both static and dynamic components. JSP technology makes available all the dynamic capabilities of Java Servlet technology but provides a more natural approach to creating static content. 

The main features of JSP technology are  

• A language for developing JSP pages, which are text-based documents that  describe how to process a request and construct a response

• An expression language for accessing server-side objects

• Mechanisms for defining extensions to the JSP language

  JSP  is  easy to  learn, robust, scalable, and  cross-platform. Java Server Pages provide the necessary dynamic features required for the                                J2EE Server . In absence of Java Server Pages if  someone requested a web page from a web site using J2EE server, the server would fetch a static WML file form disk or memory and send it out to the person’s browsers. The primary responsibility of an Web Application Server is to act as an efficient interface between browser and a bunch of files sitting on the Web server’s hard drive.

                             The main function of any Web application server is to serve  the files that are requested by the client. The process of serving an WML file is carried out, by the following steps.

1. A user enters the Internet address of an WML file into the address part of Web browsers and presses enter to request a Web page.

2. The browser sends a request for the Web page to an Web server such as          

                    Tomcat server, Personal web server.


3. The Web server receives the request and recognizes that the request if for an WML file because the requested file has the extension.wml or WML.

4. The Web server retrieves the proper WML file from disk or memory and    

 sends the files back to the browser.                                                                                                    

5. The person’s web browser interprets the WML file and the results are         displayed in the browser window.

DESCRIPTION ABOUT JAVA SERVER PAGES

 Java Server Pages (JSPs) are Web pages that contain server-side scripts in addition to the usual mixture of text and Markup Language tags . Server-side scripts are special commands you put in Web pages that are processed before the pages are sent from our  Web Server to the Web browser of someone who's visiting our Web site . When someone types a URL in the Address box or click a link on a Web page, we are asking a Web server on a computer to send a file to the Web browser (sometimes called a "client") on his computer. If that file is a normal WML file, it looks exactly the same when your Web browser receives it as it did before the Web server sent it. After receiving the file, your Web browser displays its contents as a combination of text, images, and sounds. 

                                                In the case of an Java Server Page, the process is similar, except there's an extra processing step that takes place just before the Web server sends the file. Before the Web server sends the Java  Server Page to the Web browser, it runs all server-side scripts contained in the page. Some of these scripts display the current date, time, and other information. Others process information the user has just typed into a form, such as a page in the Web site's guest book. 

                                  To distinguish them from normal web pages, Java  Server Pages are given the ".jsp" extension. 

OPERATION BEHIND A  JAVA SERVER  PAGE

 A JSP page is  just like  any  other  Markup Language  file, In addition Java  statements  are placed  within <%  and  %> tag  delimiters. Only code placed within these delimiters will be executed as Java code.
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Using Variables, and Forms in Java  Server Pages:
Forms are a convenient way to communicate with visitors to our Web site. Using forms, one can create a survey form and ask visitors to fill it out. When they fill out the form, one can process the results automatically. 

                                      With forms, there are two steps: first you create the form, and then you process it. To create a form for an Java  Server Page, just create a standard HTML form. 

                                      Java  Server Pages provide a mechanism for processing forms  unlike CGI scripting, doesn't involve serious programming: the Request.Form. 

Considering the form  we may create the file below and get a response. 

form_response.jsp   

<wml> 

<% String str=request.getParameter(“name”); %>

<card id=”mip” >

<b><%=str%> </b>

</card>

</wml> 

To display the contents of each field in the form, type:

<% =Request. sendParameter(fieldname) %>

Where fieldname is the name of the field. 

ADVANTAGES  OF  JSP:

· JSP leverages  the  power  of  Java.
                  Java  is  an object-oriented  programming  language supported by  a  complete  range of  APIs.Java  is  also  robust, threaded, scalable, secure  and  cross-platform.

· JSP  simplifies  Web  development.
                JSP  makes an easier  way  to  create  and  maintain  dynamic  pages. JSP includes  numerous  implicit objects  that  aid  the  Web  development process.

· JSP is  not  limited  to  a particular  platform  or  vendor.

                               Many   application   servers  that  run  on  a variety  of  platforms                                        

               support  JSP. BEA WebLogic,  Allaire Jrun,  IBM WebSphere, and    

               Tomcat  are  just  a  few  of  the application servers that  currently  support 
   the  JSP  specifications.

·  JSP   is  extensible.

         It   is  very  easy  to  create  custom  JavaBeans. JavaBeans are  components  that can be  reused  in other JSP Pages.

JSP in MIP

In our application the Mobile Information Provider the whole processing is done using Java Server Pages[JSP].The complete process of entering the information into the database and its validation, the process involved in retrieving these data from database and providing this data to user through his mobile handset by converting it into the WML format for the wireless communication is done using JSP.

Operations performed by JSP


In the front-end ,there is a  user-interface page designed using WML(Wireless Markup Language).The Mobile Information Provider uses these pages to collect data from the user. The data collected is validated over there using the respective   WMLscripts that are written for their validation.


The data’s collected from the user are then passed over to the server, an Web Application Server in case of the Mobile Information Provider it is a J2EE server. The process of transferring this data to the server is mediated by the Nokia WAP Gateway .The Nokia WAP Gateway has Admin View service which provides the detailed information about the file transfers in and out to Nokia Mobile Browser.

WAP [WIRELESS ACCESS PROTOCOL]

What is WAP?

The Wireless Access Protocol (WAP) is an open, global specification that empowers mobile users with wireless devices to easily access and interact with information and services instantly.

What is WAP for ?

To enable easy fast delivery of relevant information and services to mobile users. Handheld digital wireless devices such as mobile phones, pagers, two-way radios, smartphones and communicators -- from low-end to high-end.

Which wireless networks does WAP work with?

WAP is designed to work with most wireless networks such as CDPD, CDMA, GSM, PDC, PHS, TDMA, FLEX, ReFLEX, iDEN, TETRA, DECT, DataTAC, Mobitex and GRPS.

What operating systems are compatible with WAP?

WAP is a communications protocol and application environment. It can be built on any operating system including PalmOS, EPOC, Windows CE, FLEXOS, OS/9, JavaOS etc. It provides service interoperability even between different device families.

Goals of the Wireless Application Protocol 
· Independent of wireless network standard. 

· Open to all. 

· Will be proposed to the appropriate standards bodies. 

· Applications scale across transport options. 

· Applications scale across device types. 

· Extensible over time to new networks and transports. 

Applicability

The Wireless Application Protocol will be applicable to, but not limited to: 

  GSM-900, GS M-1800, GSM-1900 

  CDMA IS-95 

  TDMA IS-136 

	  3G 

	WAP Infrastructure Overview
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  WML: Wireless Markup Language - A tag-based display language providing navigational support, data input, hyperlinks, text and image presentation, and forms. A browsing language similar to Internet WML. 

  WML: Hypertext Markup Language 

  WTA: Wireless Telephony Application
Wireless Markup Language Script

Wireless Markup Language Script (WMLScript) was designed to overcome the limitations of WML for creating complicated interactions on wireless devices like pre-processing and validating data for an online ordering form.

WMLScript is similar to JavaScript. However WMLScript, keeping to the bandwidth and memory limitations of wireless devices, is more compact and simpler than JavaScript.

WMLScript and WML closely integrate with one another. Because WMLScript is run locally on the device browser, and not on a remote server, the wireless device does not have to send data to the server as often. This means visitors to your site using a wireless device have a much faster experience - and on the Internet that often can make the difference between someone both staying on your site and returning later.

RDBMS

Professional Oracle is a comprehensive operating environment that packs  the power  of a   mainframe relational  database management system into your microcomputer. It provides a set of functional programs that we can use as tools to  build  structures  and  perform  tasks.  Because  applications  developed  on  professional oracle are completely portable to other versions of the program. We can create a complex application in a single-user environment and then move it to a multi-user platform.

We can’t be  an  expert  to  appreciate  trade. But the better we understand the program, more productively and creatively we will use the tools it provides. A   Relational  system  is  a  system   that   supports   relational   databases Including in particular, the operations restrict, project and join. The formal theory underlying the relational system is called the relational model. The relational model is concerned with logical matter only, not physical matters. The objects are basically the tables.

Normalization

Normalization theory is basically a formalization of simple ideas such as a  Formalization that has practical application in the area of database design.          Designing a database can be an extremely complex task. Normalization theory is useful aid in the design process. Designing a relational database must be familiar with the basic techniques of normalization, but the design should not  be based on normalization principle alone.

Purpose of  Normalization

· To structure the data so that there is no repetition of data. So this helps in Saving space.

· To  simplify  the  maintenance  of  data  through  updates,  insertions  and deletions.

· To allow simple retrieval of data in response to query and request.

· To avoid restructuring of data when new application requirements arises.

· To structure the data so that any relationship can be easily represented.

Benefits of Normalization

· It reduces the redundancy of data.

· So inconsistency in data tables can be avoided.

· Errors while updating data tables can be avoided.

JAVA DATABASE CONNECTIVITY (JDBC)

     Java Database Connectivity (JDBC) is a programming framework for Java developers writing programs that access information stored in databases, spreadsheets, and flat files. JDBC is commonly used to connect a user program to a "behind the scenes" database, regardless of what database management software is used to control the database. In this way, JDBC is cross-platform.


The JDBC API defines Java classes to represent database connections, SQL statements, result sets, database metadata, etc. It allows a Java programmer to issue SQL statements and process the results. The JDBC API is implemented via a driver manager that can support multiple drivers connecting to different databases. JDBC drivers can either be entirely written in Java so that they can be downloaded as part of an applet, or they can be implemented using native methods to bridge to existing database access libraries. The JDBC API defines Java classes to represent database connections,SQL statements, result sets, database metadata, etc. It allows a Java programmer to issue SQL statements and process the results.


The JDBC API is implemented via a driver manager that can support multiple drivers connecting to different databases. JDBC drivers can either be entirely written in Java so that they can be downloaded as part of an applet, or they can be implemented using native methods to bridge to existing database access libraries. A database that another program links to is called a data source. Many data sources, including products produced by Microsoft and Oracle, already use a standard called Open Database Connectivity (ODBC). Many legacy C and Perl programs use ODBC to connect to data sources. ODBC consolidated much of the commonality between database management systems. JDBC builds on this feature, and increases the level of abstraction. JDBC-ODBC bridges have been created to allow Java programs to connect to ODBC-enabled database software. 

JDBC Architecture 
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Using a JDBC driver

Regardless of data source location, platform, or driver (Oracle, Microsoft, etc.), JDBC makes connecting to a data source less difficult by providing a collection of classes that abstract details of the database interaction. Software engineering with JDBC is also conducive to module reuse. Programs can easily be ported to a different infrastructure for which you have data stored (whatever platform you choose to use in the future) with only a driver substitution. 

As long as you stick with the more popular database platforms (Oracle, Informix, Microsoft, MySQL, etc.), there is almost certainly a JDBC driver written to let your programs connect and manipulate data. You can download a specific JDBC driver from the manufacturer of your database management system (DBMS) or from a third party (in the case of less popular open source products). The JDBC driver for your database will come with specific instructions to make the class files of the driver available to the Java Virtual Machine, which your program is going to run. JDBC drivers use Java's built-in DriverManager to open and access a database from within your Java program. 

To begin connecting to a data source, you first need to instantiate an object of your JDBC driver. This essentially requires only one line of code, a command to the DriverManager, telling the Java Virtual Machine to load the bytecode of your driver into memory, where its methods will be available to your program. The String parameter below is the fully qualified class name of the driver you 

To actually manipulate your database, you need to get an object of the Connection class from your driver. At the very least, your driver will need a URL for the database and parameters for access control, which usually involves standard password authentication for a database account. 

JDBC driver types:

  
JDBC drivers are divided into four types or levels. Each type defines a JDBC driver implementation with increasingly higher levels of platform independence, performance, and deployment administration. The four types are: 

· Type 1: JDBC-ODBC Bridge 

· Type 2: Native-API/partly Java driver 

· Type 3: Net-protocol/all-Java driver 

· Type 4: Native-protocol/all-Java driver 

Type 1: JDBC-ODBC Bridge 

The type 1 driver, JDBC-ODBC Bridge, translates all JDBC calls into ODBC (Open DataBase Connectivity) calls and sends them to the ODBC driver. As such, the ODBC driver, as well as, in many cases, the client database code, must be present on the client machine. Figure 1 shows a typical JDBC-ODBC Bridge environment.
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Figure 1. Type 1: JDBC-ODBC Bridge 


Pros 


The JDBC-ODBC Bridge allows access to almost any database, since the database's ODBC drivers are already available. Type 1 drivers may be useful for those companies that have an ODBC driver already installed on client machines. 

Cons 
· The performance is degraded since the JDBC call goes through the bridge to the ODBC driver, then to the native database connectivity interface. The result comes back through the reverse process. Considering the performance issue, type 1 drivers may not be suitable for large-scale applications. 

· The ODBC driver and native connectivity interface must already be installed on the client machine. Thus any advantage of using Java applets in an intranet environment is lost, since the deployment problems of traditional applications remain. 

Type 2: Native-API/partly Java driver 


JDBC driver type 2 -- the native-API/partly Java driver -- converts JDBC calls into database-specific calls for databases such as SQL Server, Informix, Oracle, or Sybase. The type 2 driver communicates directly with the database server; therefore it requires that some binary code be present on the client machine. 
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Figure 2. Type 2: Native-API/partly Java driver 


Pros 


Type 2 drivers typically offer significantly better performance than the JDBC-ODBC Bridge. 

Cons 


The vendor database library needs to be loaded on each client machine. Consequently, type 2 drivers cannot be used for the Internet. Type 2 drivers show lower performance than type 3 and type 4 drivers. 

Type 3: Net-protocol/all-Java driver 

JDBC driver type 3 -- the net-protocol/all-Java driver -- follows a three-tiered approach whereby the JDBC database requests are passed through the network to the middle-tier server. The middle-tier server then translates the request (directly or indirectly) to the database-specific native-connectivity interface to further the request to the database server. If the middle-tier server is written in Java, it can use a type 1 or type 2 JDBC driver to do this. 
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Figure 3. Type 3: Net-protocol/all-Java driver 


Pros 


The net-protocol/all-Java driver is server-based, so there is no need for any vendor database library to be present on client machines. Further, there are many opportunities to optimize portability, performance, and scalability. Moreover, the net protocol can be designed to make the client JDBC driver very small and fast to load. Additionally, a type 3 driver typically provides support for features such as caching (connections, query results, and so on), load balancing, and advanced system administration such as logging and auditing. 

Cons 


Type 3 drivers require database-specific coding to be done in the middle tier. Additionally, traversing the recordset may take longer, since the data comes through the backend server. 

Type 4: Native-protocol/all-Java driver 


The native-protocol/all-Java driver (JDBC driver type 4) converts JDBC calls into the vendor-specific database management system (DBMS) protocol so that client applications can communicate directly with the database server. Level 4 drivers are completely implemented in Java to achieve platform independence and eliminate deployment administration issues. 
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Figure 4. Type 4: Native-protocol/all-Java driver 


Pros 


Since type 4 JDBC drivers don't have to translate database requests to ODBC or a native connectivity interface or to pass the request on to another server, performance is typically quite good. Moreover, the native-protocol/all-Java driver boasts better performance than types 1 and 2. Also, there's no need to install special software on the client or server. Further, these drivers can be downloaded dynamically. 

Cons 


With type 4 drivers, the user needs a different driver for each database

JDBC-ODBC Bridge 


The JDBC-ODBC Bridge by Sun's JavaSoft -- a type 1 driver -- results from a joint effort between JavaSoft and MERANT. Available in the Java Developer Kit (JDK), this product leverages the large number of ODBC drivers available and has provided some momentum for JDBC to become widely accepted in a short time frame. 

Follow these steps to evaluate it: 

1. Create an ODBC DSN
Using the Windows Control Panel, create an ODBC DSN (data source name) for the database. 

2. Load the driver
In a JDBC program, one of the first things to do is to load the JDBC driver by calling the forName() static method of the Class class. forName() takes one string parameter: the name of the driver along with its package. For JavaSoft's JDBC-ODBC Bridge, this string is "sun.jdbc.odbc.JdbcOdbcDriver". Therefore, the call would look like: 


Class.forName("sun.jdbc.odbc.JdbcOdbcDriver");
3. Establish a database connection
Once the JDBC driver loads, you can establish a connection to the database using the DriverManager.getConnection() method. This method's first argument is a string that contains the JDBC URL for the database. The second and third parameters are the user name and password, respectively. 

A JDBC URL is formulated using the following pattern: 


jdbc:<subprotocol>:<subname>
A connection to the database could be established in this manner: 


String stUrl_= "jdbc:odbc:myDSN"; // let's say myDSN
// is the name of ODBC DSN
Connection connection_ = DriverManager.getConnection(stUrl_, "sa", "");
4.CREATE A STATEMENT :

1.Statement

2.PreparedStatement

3.CallableStatement

Statement:

The Statement interface is created from the connection object and can be used to execute standard SQL statements and procedures.

Syntax:

Statement s=<Connection object>.createStatement();

PreparedStatement:


The prepared statement interface enables you to execute dynamic SQL statement and stored procedures .Dynamic SQL statements differ from Normal SQL statements in that values in dynamic statements are not known at the time of creation 

Syntax:

String sql=”<SQL Query>”;

PreparedStatement ps=<Connection object>.prepareStatement(sql);

CallableStatement


The CallableStatement interface provides methods for executing stored procedures that return OUT parameter values .The CallableStatement object inherits PreparedStatement object ,But also adds varies methods for registering parameters to be OUT parameters and also provides methods to get  the parameters passed back from the stored procedures.

Syntax:

String sql=”<SQL Query>”;

CallableStatement cs=<Connection object>.prepareCall(sql);

Result Set


The ResultSet interface is the object that is created and used to get the informations from a SQL select statement .A SQL select statement returns a cursor that is used by the ResultSet interface to navigate through the results returned by the select statement.

Syntax:

For normal SQL selection:

ResultSet rs=<Statement object>.executeQuery();

For SQL statements which require insertion&updation

ResultSet rs=<Statement object>.executeUpdate();

5. SYSTEM ANALYSIS

PROJECT DESCRIPTION


Mobile Information Provider  [MIP] is a WAP application .It is a mobile service that the user could avail to get local information regarding the localities the Mobile Information Provider provides all necessary for the user.


The information that are provided by the Mobile Information Provider includes

· The information regarding the hotels, restaurants and other lodging facilities that are available in the locality.

· The information regarding the travel modes and travel agencies that the user make use for his travel.

· The information regarding the tourist spots and other interesting places that the user could visit in his location.

· The information regarding the trains that arrive and depart from the locality of the user.

· The information regarding the health and care facilities that  are available in the user .

PROJECT MODULES :


The Mobile Information Provider is a Wireless Application with the user interface designed using WML ,The application is run over a J2EE server


The modules of the project are

· Hotels modules

· Travel modules

· Tourist modules

· Train modules

· Health and care module

· Help  module

HOTEL MODULE:


In the hotel module ,The Mobile Information Provider provides information regarding the hospitality industries in the city .The information includes the hotels ,restaurants and other lodging facilities that are available in the city. This  module provides a detailed information regarding hotels.

· The location of the hotels with detailed description of their location along with other communication details.

· The type of the hotels whether it is a general one or a star hotel

· The facilities that are available in the hotel like the internet facilities ,the money exchange , the reservation facilities provided.

· The detailed description of the room that are available their categories , the cost for each category and their facilities.

TRAVELS MODULE:


In the travel module the Mobile Information Provider[MIP] provides information regarding the travel modes that are available in the city .The Mobile Information Provider provides the information regarding travel agencies that are present in the city and the facilities that they provide. The information includes

· Information about the travel agencies type.

· Information about the location of the travel agencies  which includes their full address along with the other communication details.

· Information about the routes they provide for the destination the user requested for.

· Information about the other destination and their routes they provide.

· Information about the cost for each route based on the mode of transport.

TOURIST MODULE:


In the tourist module the Mobile Information Provider [MIP]  provides information regarding the tourist spots and interesting places in the city. The Mobile Information Provider gives information about all the  places of importance to the user of the service. The Mobile Information Provider provides detailed information which includes

· Information about the correct location of these places

· The different modes of transport to access these places

· The cost in case of each mode of transport  .

· The full description of the location with its historical importance ,geographical description ,events of importance in these places.

TRAIN MODULE:

In the train module the Mobile Information Provider [MIP] provides information regarding the trains arriving and departing in the city. The Mobile Information Provider gives a detailed description regarding the trains that the user could avail for his further travel. The information includes

· Information about the train name and their identification.

· Information about their arrival time and departure from the station.

· Information about which train to avail for travel to a destination.

· Information about the cost for travel in the route.

HEALTH AND CARE MODULE:


In the health and care module the Mobile Information Provider [MIP] provides information regarding the health and care facilities that are available in the city. The Mobile Information Provider gives a detailed description about the hospitals, clinics and other health care centers that are present in the city. The information includes

· Detailed description about the location along with the other communication details that are available.

· The facilities that are available in the hospital like MRT scans, Medical store ,X-Rays and other equipments present for accurate diagnosis.

· Information about the doctors of the respective hospitals ,their designation , modes for communication and their specialization.

· The distinguishing features of the hospitals

HELP MODULE:


In the help module the Mobile Information Provider [MIP] provides information regarding the services provided by the MIP to the user of the its service .The procedures that are to be followed to access these services.
EXISTING SYSTEM

In the existing system the user who wishes to travel to a new location for an tour or for an new assignment had to collect information regarding the location prior to his trip .In the  past he had to fully depend on the maps sold in the market for their information or the guides of the local location for their travel through the locality.

· This model suffers from a number of drawbacks like 

· The information are not upto date.The map could show something from what he sees.

· Inavailability of information regarding the location he requires.

· Additional charges

· Lack of comfort due to inconveniences .

In near past after the development of computers and the Internet running on them.The problem is less suppressed but still  some problems prevail .The problem that are to be encountered are that the  informations are to be downloaded and carried along with.Additional effort are to be taken to gather informations .

PROPOSED SYSTEM

The proposed solution for this problem could be found through the mobile technology. Every improvement in technology is made for additional Comfort and faster solutions for problems. The mobile technology avails these advantages.

The Mobile Information Provider[MIP] is the solution we had designed for these problems. An mobile application which provides all the information the user of its service requires. 

The future we aim would provide all the in formations to the user by the click of his finger over the mobile keypad. The information would be handy providing additional comfort. The user need not had to take effort to collect informations. He would not require any prior plan before his travel.He could surf those informations that he requires on the way of his travel through his mobile.

6.testing

                                     Software testing is an important element of S/W quality assurance and represents the ultimate review of specification, design and coding. The increasing visibility of S/W as a system element and the costs associated with a S/W failure are motivating forces for well planned, through testing.

                                    Though the test phase is often thought of as separate and distinct from the development effort--first develop, and then test--testing is a concurrent process that provides valuable information for the development team. 

                                    There are at least three options for integrating Project Builder into the test phase: 

· Testers do not install Project Builder, use Project Builder functionality to compile and source-control the modules to be tested and hand them off to the testers, whose process remains unchanged. 

· The testers import the same project or projects that the developers use. 

· Create a project based on the development project but customized for the testers (for example, it does not include support documents, specs, or source), who import it. 

  A combination of the second and third options works best. Associating the application with a project can be useful during the testing phase, as well. We can create actions to automatically run test scripts or add script types and make them dependent on the modules to test.

testing objectives:

        There are several rules that can serve as testing objectives.

They are

1. Testing is a process of executing a program with the intent of finding an error.

2. A good test case is one that has a high probability of finding an undiscovered error.

3. A successful test is one that uncovers an undiscovered error.

                If testing is conducted successfully according to the objectives stated above, it will uncover errors in the software. Also, testing demonstrates that software functions appear to the working according to specification, that performance requirements appear to have been met.

UNIT TESTING:

                                    Unit testing focuses the verification effort on the smallest unit of S/W design i.e., the module. The unit testing is always white-box oriented and the step can be conducted in parallel for modules.

                                  During unit test, testers can use the same project or projects as the developers, if functional units organize the project, or separate projects have been created for functional units. The project or projects can also be exported, so unit test can take place in a variety of environments and on a variety of platforms.

Unit test considerations:

                             The tests that occur as part of unit testing. The module ‘interface’ is tested to ensure that information properly flows into and out of the program unit under test. The ‘local data structures’ are examined to ensure that data stored temporarily maintains its integrity during all steps in an algorithms execution.

                              ‘Boundary Conditions’ are tested to ensure that the module operates properly at boundaries established to limit or restrict processing. All ‘independent paths’ through the control structures are exercised to ensure that all statements in a module have been executed at least once. Finally, all ‘error-handling paths’ are tested.

UNIT TEst PROCEDURE:

                                Unit testing is considered an equivalent to the coding step. After the source level code has been developed, reviewed and verified for correct syntax, unit test case design begins since a module is not a stand alone program, ‘driver’ and/or ‘stub’ S/W must be developed for each unit test.

 In most applications, a driver is nothing more than a main program that accepts test case data, passes such data to the module to be tested, and prints the relevant results. The stubs serve to replace modules that are subordinates called by the modules to be tested. A stub or a dummy stub or a dummy subprogram uses the subordinate modules interface, may do minimal data manipulation, prints verification of entry, and returns. The drivers and scrubs represent overhead i.e., both are S/W that must be written but that is not delivered with the final S/W product. If the drivers and the stub are kept simple, then the overhead is low.

The Unit Test is carried out in this project, and is found successful.  The data is flowing correctly to all part of the project.

INTEGRATION TESTING:

                           Integration testing is a systematic technique for constructing the program structure while at the same time conducting test to uncover errors associated with interfacing. The objective is to take unit-tested modules and build a program structure that has been dictated by design.

Top-down integration:

1.            This method is an incremental approach to the construction of program structure. Modules are integrated by moving downward through the control hierarchy, beginning with the main program module.

 Importing the test project and setting up the testing environment:

                           The process of importing a test project and setting up a testing environment is the same as the process for importing a project and setting up the environment for development. 

Adding test scripts and test data to the project:

                            You may need to add some items, such as test scripts, to the project. In addition, you may need to add connection strings to database accounts containing test data. 

                           Remember that you can automate the running of test scripts just as you can automate actions associated with the modules in your application. 

Modifying actions and macros to facilitate testing:

                          If actions specifying "run with debugging" have not already been provided, you can either modify existing actions to include a debug flag, or create new actions.

7. SYSTEM IMPLEMENTATION

To set up the Running Environment:

· First Install  jdk1.4 (Java Development Kit)

· Install Nokia Mobile Internet Toolkit verson 4.0

· While Installation of the Nokia Internet ToolKit provide the target directory.

· Install Nokia 5100 SDK device similar to the NMIT 4.0 by providing the respective user valid password.

To Set up the Server:

· To Install the J2EE Server ,first it is required to install  jdk1.3.

Server Configuration:

· Set path=c:\j2sdkee1.2.1\bin

· Set ClassPath=c:\j2sdkee1.2.1\lib\j2ee.jar

· Set J2EE_HOME=c:\j2sdkee1.2.1

· Set JAVA_HOME=c:\j2sdk1.4.0_02

To Load  the Project:

• By opening a local file (File>Open).

• By opening a URL on the Internet (File>Open) - but first you might have to set up an HTTP proxy server.This method is called browsing.
• By loading content from a supporting application within an IDE. NMIT and Adobe GoLive let you display content on the SDK that you’ve developed with their editors.

You can view the content by either clicking a button or making a menu selection in

the application. This method is called previewing.

You can load content on the SDK with File>Open or by using the menus on the SDK (as you would on the handset).

Loading Content With File>Open

To load content into the SDK when you are using the SDK as a standalone application:

1 Select File>Open. This dialog box appears:
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2 Do one of the following:

• To open a local file, enter the full path of the file you want to open.

• To open mobile Internet content, enter a URL.

3 Click OK.

The SDK loads the content.

Loading Content Using the SDK Menus

You can also load a web site using the menus on the SDK .

For example:

1 Select Menu>Services>Go To Address.

2 Enter: http:\\www.yahoo.com .

3 Select Options.

4 Select OK.

The site, Yahoo.com, loads on the browser.

Previewing and Browsing With NMIT:

You can preview local files and browse mobile Internet content on the SDK when you use Nokia Mobile Internet Toolkit.
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Working With Phone SDKs

The SDK Control Panel, or simply “the panel,” enables you to perform the following functions:

• View all phone SDKs installed on your computer that work with NMIT.

• Launch and close any of the displayed phone SDKs.

• Enter a URL directly or from a bookmark and see it displayed on all running phone SDKs that

have been launched from the panel.

• Create and save bookmarks so that you can conveniently display frequently accessed mobile

Internet and local file content.

Choosing Tools>SDK Control Panel displays the panel. In the following figure, three phone

SDKs are displayed. These SDKs were “discovered” by NMIT upon launch:
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• If you first launch NMIT and then launch a phone SDK standalone or through another

program, NMIT does not “discover” it and does not list it in its SDK Control Panel. Thus, it

is not possible to “refresh” the NMIT discovery procedure.

The following main topics are described in subsequent sections:

Launching and Closing Phone SDKs

To start a phone SDK, click the  [image: image14.bmp] button adjacent to its name.
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After clicking the button adjacent to Nokia 7210, NMIT launches the Nokia 7210 SDK. The  panel displays this changed state as follows:
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Click the “x” to the right of the instance number to close that instance.

You may launch multiple phone SDK instances if this is supported by the SDK. The Nokia

NMB, 7210 and 3510i SDKs support multiple instances; the Series 60 Content Authoring

SDK does not. The following figure shows the panel after clicking the button [image: image17.bmp] adjacent to

Nokia 7210 a second time:
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Displaying Editor Content on Phone SDKs

This section describes the sending a document content from an NMIT editor to multiple SDKs. The procedure is the same for all of the document content types: WML, XHTML, Push types, and MMS messages. The figure shown following the procedure depicts the sending of a WML document to both the Nokia 3510i and the Nokia 7210 SDKs.

1) Ensure that the phone SDKs to which you wish to send the document support the content type of the document you are sending. Some phone SDKs do not support some content

types. 

2) Launch each phone SDK that you wish to receive the content. An instance of the newly

launched phone SDKs are displayed below the SDK names in the panel. By default, a

check mark is placed to the left of the instance numbers, indicating they will receive any

future document that you send.

3 ) Within NMIT, choose the Show button. As shown in the following figure, the phone SDK instances selected to receive the content display a “Loading” message status, and the

content is displayed on both phone SDKs. Note also that the Go text entry bar in the SDK

Control Panel displays the content currently being displayed.
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SOURCE CODE

/* MIP Main Page  */

<?xml version="1.0" encoding="utf-8"?> 

<!DOCTYPE wml PUBLIC "-//WAPFORUM//DTD WML 1.3//EN" 

     "http://www.wapforum.org/DTD/wml13.dtd"> 

<wml> 

  <!-- Possible <head> elements here. --> 

   <template> 

    <!-- Template implementation here. --> 

    <do type="prev"><prev/></do> 

  </template> 

  <card id="card1" title="MIP"> 

 <do type="accept" label=”mip” >

 <go href="#hospital"/>

 </onevent> 

 <p align="center"> 

 <img src="bee.wbmp" alt="arivallini"  align="top" height="10" width="10" vspace="1" hspace="1"/>

<br/>  

<big><b><i> MOBILE INFORMATION PROVIDER</i></b></big> 

</p> 

</card> 

<card id="hospital" title="hospital">

<p align="center">

<b><i><u>Hospital</u></i></b>

<img src="hosp.wbmp" alt="Hospital"  align="top" height="10" width="10" vspace="1" hspace="1"/>

</p>

<do type="options" label="next">

<go href="#hotel"/>

</do>

<do type="accept" label="accept">

<go href="http://localhost:8000/sarav/hospital.jsp"/>

</do>

</card>

<card id="hotel" title="hotel">

<p align="center">

<b><i><u>Hotel</u></i></b>

<img src="hotel.wbmp" alt="Hotel"  align="top" height="10" width="10" vspace="1" hspace="1"/>

 </p>

<do type="options" label="next">

<go href="#tourist"/>

</do>

<do type="accept" label="accept">

<go href="http://localhost:8000/sarav/hotel.jsp"/>

</do>

</card>

<card id="tourist" title="tourist spots">

<p align="center">

<b><i><u>Tourist spots</u></i></b>

<img src="tour.wbmp" alt="Tourist Place"  align="top" height="10" width="10" vspace="1" hspace="1"/>

</p>

<do type="options" label="next">

<go href="#train"/>

</do>

<do type="accept" label="accept">

<go href="http://localhost:8000/sarav/place.jsp"/>

</do>

</card>

<card id="train" title="train">

<p align="center">

<b><i><u>Train</u></i></b>

<img src="nws10.wbmp" alt="arivallini"  align="top" height="10" width="10" vspace="1" hspace="1"/>

</p>

<do type="options" label="next">

<go href="#travels"/>

</do>

<do type="accept" label="accept">

<go href="http://localhost:8000/sarav/madtrain.jsp"/>

</do>

</card>

<card id="travels" title="travels">

<p>

<b><i><u>Travels</u></i></b>

<img src="mam.wbmp" alt="arivallini"  align="top" height="10" width="10" vspace="1" hspace="1"/>

 </p>

<do type="options" label="next">

<go href="#help"/>

</do>

<do type="accept" label="accept">

<go href="http://localhost:8000/sarav/travels.jsp"/>

</do>

</card>

<card id="help" title="help">

<p align="center">

<b><i><u>Help</u></i></b>

</p>

<do type="options" label="next">

<go href="#hospital"/>

</do>

<do type="accept" label="accept">

<go href="http://localhost:8000/sarav/help.jsp"/>

</do>

</card>

</wml>

/* Hospital.jsp */

<%@ page language="java" import="java.io.*,java.util.*,java.sql.*,java.lang.*" %>

<% response.setContentType("text/vnd.wap.wml"); %>

<?xml version="1.0"?>

<!DOCTYPE wml PUBLIC "-//WAPFORUM//DTD WML 1.1//EN" "http://www.wapforum.org/DTD/wml_1.1.xml">

<wml>

<card id="hospital" title="Hospital List" >

<p align="center" >

<%

String str=request.getParameter("name");

%>

<b> Hospital </b>

<br/>

<select  name="hospital">

<%

try

{

Class.forName("sun.jdbc.odbc.JdbcOdbcDriver");

}

catch(Exception e)

{ }

%>

<%

try

{

Connection cn=DriverManager.getConnection("Jdbc:Odbc:sarav");

String sql="select hosid,hosname from maduraihosp where hloc=? ";

PreparedStatement s=cn.prepareStatement(sql);

s.setString(1,str);

ResultSet rs=s.executeQuery();

while(rs.next())

{

%>

<option value="<%=rs.getString(1)%>" >

<%=rs.getString(2)%>

<onevent type="onpick">

<go href="http://localhost:8000/sarav/hossel.jsp">

<postfield name="hospital" value=$hospital />


</go>

</onevent>

</option>

<%

}

rs.close();

s.close();

cn.close();

}

catch(Exception ce){System.err.println(ce); }

%>

</select>

</p>

</card>

</wml> 

/*  Selection.jsp */

<%@ page language="java" import="java.io.*,java.util.*,java.sql.*,java.lang.*" %>

<% response.setContentType("text/vnd.wap.wml"); %>

<?xml version="1.0"?>

<!DOCTYPE wml PUBLIC "-//WAPFORUM//DTD WML 1.1//EN" "http://www.wapforum.org/DTD/wml_1.1.xml">

<wml>

<card title="Select" >

<p>

<%

String str=request.getParameter("hospital");

%>

<select name=detinfo>

<option value="general detail">

General detail

<onevent type="onpick">

<go method="post" href="http://localhost:8000/sarav/hospinfo.jsp?hospital=<%=str%>" />

</onevent>

</option>

<option value="doctor detail">

Doctor's detail

<onevent type="onpick">

<go method="post" href="http://localhost:8000/sarav/doctor.jsp?hospital=<%=str%>" />

</onevent>

</option>

<option value="hospital feature">

hospital Feature

<onevent type="onpick">

<go method="post" href="http://localhost:8000/sarav/hosfeat.jsp?hospital=<%=str%>" />

</onevent>

</option>

</select>

</p>

</card>

</wml>

/* Hospital Details.jsp */

<%@ page language="java" import="java.io.*,java.util.*,java.sql.*,java.lang.*" %>

<% response.setContentType("text/vnd.wap.wml"); %>

<?xml version="1.0"?>

<!DOCTYPE wml PUBLIC "-//WAPFORUM//DTD WML 1.1//EN" "http://www.wapforum.org/DTD/wml_1.1.xml">

<wml>

<card title="Hospital Information" >

<p> 

<% String str=request.getParameter("hospital"); %>

<table columns="2" >

<%

try

{

Class.forName("sun.jdbc.odbc.JdbcOdbcDriver");

}

catch(Exception e)

{ }

%>

<%

try

{

Connection cn=DriverManager.getConnection("Jdbc:Odbc:sarav");

String sql="select hosname,hosaddr,hloc,hostype,special from maduraihosp where hosid=? ";

PreparedStatement s=cn.prepareStatement(sql);

s.setString(1,str);

ResultSet rs=s.executeQuery();

while(rs.next())

{

%>

<tr><td>Name</td><td><%=rs.getString(1)%></td></tr>

<tr><td>Address</td><td><%=rs.getString(2)%></td></tr>

<tr><td>Location</td><td><%=rs.getString(3)%></td></tr>

<tr><td>Type</td><td><%=rs.getString(4)%></td></tr>

<tr><td>Features</td><td><%=rs.getString(5)%></td></tr>

<%

}

rs.close();

s.close();

cn.close();

}

catch(Exception ce){System.err.println(ce); }

%>

</table>

</p>

</card>

</wml>

/* Travels mode selection */

<%@ page language="java" import="java.io.*,java.util.*,java.sql.*,java.lang.*" %>

<% response.setContentType("text/vnd.wap.wml"); %>

<?xml version="1.0" encoding="utf-8"?> 

<!DOCTYPE wml PUBLIC "-//WAPFORUM//DTD WML 1.3//EN" 

  "http://www.wapforum.org/DTD/wml13.dtd"> 

<wml> 

<!-- Possible <head> elements here. --> 

<template> 

<!-- Template implementation here. --> 

<do type="prev"><prev/></do> 

</template> 

<card id="travel" title="Travels"> 

<!-- Additional <do> elements here. --> 

<p align="center"> 

<!-- Card implementation here. --> 

<big><b><u>Travels</u></b></big>

<select name="mode">

<option value="bus">

Bus 

<onevent type="onpick">

<go href="http://localhost:8000/sarav/bus2.jsp">

</go>

</onevent>

</option>

<option value="train">

Train

<onevent type="onpick">

<go href="http://localhost:8000/sarav/madtravels.jsp">

<postfield name="mode" value="$mode" />


</go>

</onevent>

</option>

<option value="air" >

Air

<onevent type="onpick">

<go href="http://localhost:8000/sarav/madtravels.jsp">

<postfield name="mode" value="$mode" />


</go>

</onevent>

</option>

<option value="van/car">

Van/Car

<onevent type="onpick">

<go href="http://localhost:8000/sarav/madtravels.jsp">

<postfield name="mode" value="$mode"/>


</go>

</onevent>

</option>

</select>

</p>   

</card>

/* Hotel  */

<%@ page language="java" import="java.io.*,java.util.*,java.sql.*,java.lang.*" %>

<% response.setContentType("text/vnd.wap.wml"); %>

<?xml version="1.0"?>

<!DOCTYPE wml PUBLIC "-//WAPFORUM//DTD WML 1.1//EN" "http://www.wapforum.org/DTD/wml_1.1.xml">

<wml>

<card title="Hotel List" >

<p align="center" >

<%

String str=request.getParameter("name");

%>

<b> Hotel </b>

<br/>

<select  name="hotel">

<%

try

{

Class.forName("sun.jdbc.odbc.JdbcOdbcDriver");

}

catch(Exception e)

{ }

%>

<%

try

{

Connection cn=DriverManager.getConnection("Jdbc:Odbc:sarav");

String sql="select hotelid,hotelname from maduraihotel where hloc=? ";

PreparedStatement s=cn.prepareStatement(sql);

s.setString(1,str);

ResultSet rs=s.executeQuery();

while(rs.next())

{

%>

<option value="<%=rs.getString(1)%>" >

<%=rs.getString(2)%>

<onevent type="onpick">

<go href="http://localhost:8000/sarav/hotinfo.jsp">

<postfield name="hotel" value=$hotel />


</go>

</onevent>

</option>

<%

}

rs.close();

s.close();

cn.close();

}

catch(Exception ce){System.err.println(ce); }

%>

</select>

</p>

</card>

</wml> 

ANNEXURE

LIST OF TABLES WITH FIELDS DESCRIPTION

CONTENT TYPE SUPPORTED BY WML

ABOUT WML TAGS
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CONCLUSION


The Mobile Information Provider (MIP)  is a mobile application to provide information handy to the user has been developed to provide ease and comfort to its users . The MIP provides its user with essential information regarding the locality.
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